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Les symboles ci-dessus avertissent l’utilisateur des dangers
potentiels découlant d’une mauvaise utilisation d’appareils
électriques. Le symbole de l’éclair placé dans un triangle
équilatéral indique la présence de tensions électriques
pouvant provoquer des risques d’électrocution. Le symbo-
le du point d’exclamation souligne des consignes d’utilisa-
tion ou de sécurité à respecter.

Ces symboles vous indiquent qu’aucune des pièces
internes de l’appareil n’est réparable par l’utilisateur.
N’ouvrez pas l’appareil. Ne tentez pas de réparer l’appareil
par vous-même. Confiez toutes les réparations à un tech-
nicien qualifié. L’ouverture de l’appareil annulerait la garan-
tie fabricant. Ne laissez pas l’appareil à proximité de
liquides. Si du liquide s’est infiltré dans l’appareil, éteignez
immédiatement ce dernier et confiez-le à votre revendeur.
Débranchez l’appareil par temps d’orage.

AT T E N T I O NT E N T I O N
RISQUE D'ÉLECTROCUTION

NE PAS OUVRIR

 :  RISQUE D'ÉLECTROCUTION NE PAS OUVRIR

ATTENTION :  Pour éviter tout risque d'électrocution ou d'incendie, ne pas 
exposer cet appareil à la pluie ou à l'humidité 

CONSIGNES DE SÉCURITÉ

NOTE POUR CLIENTS DONT L’APPAREIL EST ÉQUIPÉ D’UN
CORDON D’ALIMENTATION.

AVERTISSEMENT : CET APPAREIL DOIT ÊTRE RELIÉ À LA
TERRE.

Les conducteurs du cordon secteur présentent le code couleur suivant :

VERT et JAUNE - Terre        BLEU - Neutre        MARRON - Phase

Il se peut que le code couleur ci-dessus ne corresponde pas à celui de
votre cordon secteur. Dans ce cas, veuillez suivre la procédure ci-dessous
:

• Le conducteur vert et jaune doit être relié à la borne de la fiche repé-
rée par la lettre E, par le symbole de terre ou par la couleur vert ou
vert- jaune.

• Le conducteur bleu doit être relié à la borne de la fiche repérée par la
lettre N ou la couleur noire.

• Le conducteur marron doit être relié à la borne repérée par la lettre
L ou par la couleur rouge.

Cet appareil peut nécessiter un cordon secteur et/ou une fiche secteur dif-
férent(e) en fonction de l’installation électrique de votre domicile. Faites
toujours remplacer la fiche du cordon électrique par un technicien qualifié.
Celui-ci devra reprendre les réglages indiqués dans le tableau ci-dessous.
Le conducteur vert/jaune doit être relié directement au boîtier de l’appareil.

AVERTISSEMENT : Si la borne de masse est désactivée, certains dys-
fonctionnements de l’appareil ou du système auquel il est relié peuvent
entraîner des différences de potentiel électrique dangereuses entre le boî-
tier et la terre. Des risques mortels d’électrocution peuvent alors se pro-
duire si vous touchez simultanément le boîtier et la terre.

PILE AU LITHIUM
AVERTISSEMENT

CAUTION!
This product may contain a lithium battery.There is dan-
ger of explosion if the battery is incorrectly replaced.
Replace only with an Eveready CR 2032 or equivalent.
Make sure the battery is installed with the correct pola-
rity. Discard used batteries according to manufacturer’s
instructions.
ATTENTION !
Cet appareil est équipé d’une pile au lithium. Une mau-
vaise manipulation lors de son échange peut provoquer
un risque d’explosion. Remplacez-la par une pile de type
Eveready CR 2032 ou équivalent. Respectez la polarité
de la pile. Jetez les piles usées conformément aux ins-
tructions du fabricant.
ADVARSEL!
Lithiumbatteri - Eksplosionsfare ved fejlagtig håndtering.
Udskiftning må kun ske med batteri av samme fabrikat og
type. Levér det brugte batteri tilbage til leverandøren.
VARNING!
Explosionsfara vid felaktigt batteribyte.Använd samma
batterityp eller en ekvivalent typ som rekommenderas av
apparattillverkaren. Kassera använt batteri enligt fabrikan-
tens instruktion.

COMPATIBILITÉ
ÉLECTROMAGNÉTIQUE

L’appareil est conforme aux normes indiquées dans la

Déclaration de Conformité. Il doit respecter les

2 clauses suivantes :

• L’appareil ne génère pas d’interférences parasites,

• L’appareil doit accepter toutes les interférences

qu’il reçoit, même si elles perturbent son bon

fonctionnement.

Éloignez l’appareil de tout champ électromagnétique

puissant.

• Utilisez des câbles de connexion blindés.

IMPORTANT SAFETY INFORMATION



CONSIGNES DE SÉCURITÉ

DÉCLARATION DE CONFORMITÉ

Nom du fabricant : DigiTech
Adresse du fabricant : 8760 S. Sandy Parkway

Sandy, Utah 84070, États-Unis

déclare que le produit :

Nom du produit : Vx400

Option : Toutes (nécessite un adaptateur secteur de Classe II conforme aux                       
normes EN60065, EN60742 ou équivalent).

est conforme aux normes suivantes :

Sécurité : IEC 60065-98

Compatibilité électromagnétique : EN 55013 (1990)
EN 55020 (1991)

Informations complémentaires :

Ce produit est conforme à la directive sur les appareils basse tension 72/23/EEC et à la directive sur la com-
patibilité électromagnétique 89/336/EEC comme amendé par la  directive 93/68/EEC.

Vice-President of Engineering
8760 S. Sandy Parkway
Sandy, Utah 84070, États-Unis
Date : 17 Avril 2003

Contact en Europe : Distributeur DigiTech local ou 

Harman Music Group
8760 South Sandy Parkway
Sandy, Utah  84070, États-Unis
Tél. : (801) 566-8800
Fax : (801) 568-7583

INSTRUCTIONS À SUIVRE
LIRE LES CONSIGNES SUIVANTES :

CONSERVEZ CES CONSIGNES.

OBSERVEZ LES AVERTISSEMENTS.

RESPECTEZ TOUTES LES CONSIGNES.

N’UTILISEZ PAS CET APPAREIL À PROXIMITÉ DE L’EAU.

NETTOYEZ L’APPAREIL UNIQUEMENT AVEC UN CHIFFON
HUMIDE.

N’OBSTRUEZ PAS LES OUÏES DE VENTILATION. INSTALLEZ
L’APPAREIL SELON LES INSTRUCTIONS DU FABRICANT.

ÉLOIGNEZ L’APPAREIL DE TOUTE SOURCE DE CHALEUR
COMME LES RADIATEURS, LES FOURS ET MÊME LES AMPLI-
FICATEURS.

UTILISEZ EXCLUSIVEMENT LES FIXATIONS ET ACCES-
SOIRES PRÉCONISÉS PAR LE FABRICANT.

DÉBRANCHEZ L’APPAREIL DU SECTEUR PAR TEMPS
D’ORAGE OU EN CAS DE NON UTILISATION
PROLONGÉE.

Respectez la polarité ou la mise à la terre de la prise secteur.
Une prise secteur polarisée présente deux bornes dont une
plus large que l’autre. Une prise avec mise à la terre est équi-
pée de deux fiches et d’une borne de masse. Cette borne de
masse garantit la sécurité du dispositif. Si la prise secteur n’est
pas compatible avec votre installation, faites remplacer la prise
secteur obsolète par un électricien.

Veillez à ne pas marcher sur le cordon secteur et à ne pas le
pincer, en particulier au niveau des prises secteur et de l’em-
base secteur de l’appareil.

Utilisez uniquement supports, tables et chariots recommandés
par le fabricant ou vendus avec l’appareil. Lorsque vous utilisez
un chariot pour déplacer l’appareil, prenez les précautions
nécessaires pour éviter toute blessure en cas de chute

.

Faites appel à un technicien qualifié pour toute réparation.
L’intervention d’un technicien est nécessaire dès que l’appareil
a été endommagé (prise ou cordon secteur endommagé, pro-
jection de liquides ou introduction d’objets étrangers à l’inté-
rieur de l’appareil, signes de dysfonctionnements, chute de l’ap-
pareil).

U.K. MAINS PLUG WARNING

A molded mains plug that has been cut off from
the cord is unsafe. Discard the mains plug at a
suitable disposal facility. NEVER UNDER ANY
CIRCUMSTANCES SHOULD YOU INSERT A
DAMAGED OR CUT MAINS PLUG INTO A 13
AMP POWER SOCKET. Do not use the mains
plug without the fuse cover in place. Replacement
fuse covers can be obtained from your local retail-
er. Replacement fuses are 13 amps and MUST be
ASTA approved to BS1362.



Garantie
Nous sommes très fiers des produits que nous fabriquons. C’est pourquoi DigiTech garantit ses produits.
Garantie : Les termes de la garantie et les dommages couverts dépendent du pays de distribution du produit.
Nous vous conseillons de consulter votre revendeur ou l’importateur agréé de votre pays.

REMARQUE : Les informations contenues dans ce mode d’emploi sont susceptibles d’être modifiées sans
préavis. Certaines informations relatives au produit ou au système d’exploitation peuvent donc s’avérer
inexactes au moment de l’impression de ce mode d’emploi. Les informations contenues dans cette version du
mode d’emploi annulent et remplacent toutes les précédentes.
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Nous tenons à vous remercier d’avoir choisi le Vx400. Le Vx400 représente une véritable innovation dans le
mode du traitement pour chants, vous offrant les outils dont vous avez besoin sur scène et les fonctions pro-
fessionnelles dont vous avez besoin en studio. Prenez le temps de lire ce mode d’emploi tout en utilisant le
processeur — il vous permettra d’exploiter au mieux toutes les fonctions du Vx400.

Éléments fournis
Avant de commencer, contrôlez que vous disposez des éléments suivants :

• Processeur vocal et Interface USB Vx400
• CD de logiciel X-Edit
• CD de logiciel Pro Tracks
• Câble USB 
• Adaptateur secteur PS0913B
• Carte de garantie

Nous avons apporté le plus grand soin à la fabrication de ce RPx400. Si un élément venait à manquer,
contactez immédiatement l’usine ou votre revendeur. Remplissez également la carte de garantie nous per-
mettant de mieux vous connaître et de mieux répondre à vos besoins. En cas de problème, la garantie
couvre votre Vx400.

Face avant

1. Pédales Haut/Bas — Ces deux pédales permettent de sélectionner les Presets, d’accéder à l’accordeur du
Vx400. La pédale de gauche permet de passer au Preset inférieur. Celle du milieu permet de sélectionner le
Preset supérieur.Appuyez simultanément sur les deux pédales pour passer en mode d’accordage.
2. Bypass Footswitch — Cette pédale bypasse le Preset sélectionné. Utilisée avec la pédale Haut, elle vous
permet d’accéder aux fonctions d’enregistrement, lorsque le Vx400 est connecté à votre ordinateur par USB.
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3. Boutons — Ces boutons offrent diverses fonctions selon le mode sélectionné ou lorsque le Vx400 est
connecté à votre ordinateur par liaison USB. En utilisation normale, les boutons contrôlent les paramètres
Bass EQ, Mid EQ,Treble EQ et Master Level. Si le Vx400 est connecté à l’ordinateur par liaison USB, les fonc-
tions des boutons 2, 3, et 4 sont : Playback Mix, USB 1-2 Send Level et USB 3-4 Send Level. Lors de l’édition
ou de l’accès aux fonctions de configuration Setup, les boutons règlent les valeurs de paramètres affichées
directement au-dessus de chaque bouton, pour l’effet sélectionné. Lorsque vous utilisez la boîte à rythme, les
boutons contrôlent les paramètres Pattern,Tempo et Level. En mode accordeur, les boutons servent à sélec-
tionner la référence d’accordage.

4. Touche Select — Cette touche vous permet de passer en mode d’édition et sélectionne les effets à éditer.
Appuyez plusieurs fois pour faire défiler les effets disponibles.Vous pouvez utiliser cette touche comme rac-
courci.Tout d’abord, maintenez la touche enfoncées pour quitter n’importe quelle fonction du mode d’édi-
tion. Elle vous permet également de vous rendre directement dans la rangée de configuration du tableau d’ef-
fet, en la maintenant enfoncée lmorsque vous êtes en mode de jeu.

5. Touche Drums — Cette touche active/désactive la boîte à rythmes intégrée. Lorsque la boîte à rythmes
est active, les Leds Drums s’allument et le Pattern de batterie sélectionné est lu en boucle.

6. Tableau — Le tableau fournit des informations sur le Preset courant et sur les fonctions d’édition des
paramètres. En mode de jeu, les Leds de gauche indiquent les effets utilisés par le Preset sélectionné. En
mode d’édition, les Leds indiquent l’effet sélectionné pour l’édition.

7. Écran — L’écran fournit les informations sur diverses fonctions, selon le mode actif. En mode de jeu,
l’écran indique le nom du Preset sélectionné et son numéro. En mode d’édition, l’écran indique le nom et la
valeur du paramètre sélectionné. En mode accordeur, l’écran indique la note jouée et si elle est trop basse,
juste ou trop haute.

8. Touche Store — Cette touche sauvegarde vos modifications dans un Preset utilisateur.

9. Pédale d’expression — La pédale d’expression permet de modifier en temps réel trois des paramètres
d’effet qui lui sont affectés. Presque tous les paramètres peuvent être contrôlés par la pédale d’expression.

Face arrière

1. Instrument In — Utilisez ce jack pour connecter votre instrument.
2. Mic Level — Contrôle le gain de l’entrée micro.

Introduction
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3. Entrée micro — Connectez un micro pour l’enregistrement ou le mixage sur scène de sources acous-
tiques dans le Vx400. Le signal du micro peut être traité ou non par le Vx400 ; sur scène ou pour enregistrer.
Compatible avec les micros dynamiques ou à condensateur, alimentés par fantôme.

4. Entrées ligne Left/Right — Utilisez ces entrées pour vos sources à niveau ligne pour l’enregistrement ou la
scène (mixage dans le Vx400). Les signaux ligne peuvent être traités ou non par le Vx400 ; sur scène ou pour
enregistrer.

5. Entrées CD/Monitor In — Utilisez ces entrées pour connecter la sortie casque d’un lecteur de CD ou
MP3 pour l’écoute. Peuvent également être utilisées comme entrée d’écoute du mixage de sortie de la carte
son de votre ordinateur.

Remarque : L’utilisation de l’entrée CD/Monitor pour l’écoute en temps réel peut induire
des temps de retard, selon la vitesse de votre ordinateur.

6. Embase casque — Utilisez cette embase Jack 3,5 mm pour connecter votre casque stéréo.

7. Sorties ligne en Jack 6,35 mm — Connectez ces sorties asymétriques aux entrées Jack asymétriques de
votre amplificateur ou de votre console de mixage.

8. Sorties ligne symétriques — Connectez ces sorties à vote amplificateur de puissance, système de sonori-
sation, console de mixage offrant des entrées symétriques XLR.

9. Embase USB — Connectez cette embase USB au port USB de votre ordinateur pour enregistrer (voir
page 25, sur les fonctions USB).

ATTENTION : Connectez le Vx400 à votre ordinateur avant d’installez les Drivers USB si
vous utilisez Windows XP. Si vous utilisez un système d’exploitation autre que Windows XP,
installez les Drivers USB fournis sur le CD X-Edit Software avant de connecter le Vx400 à
votre ordinateur par le câble USB.

10. Embase Footswitch — Connectez le RPxFC à 3 contacts à ce Jack. Le RPxFC vous permet de comman-
der à distance les fonctions d’enregistrement du RPx400 (voir page 31, sur les fonctions du RPxFC).

11. Embase d’adaptateur secteur — Connectez uniquement l’adaptateur secteur DigiTech PS0913B à ce Jack.
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Connexions
Il y a différentes façons de connecter le Vx400. Avant de connecter le Vx400, assurez-vous que votre amplifi-
cateur et que le Vx400 sont placés hors tension. Le Vx400 ne dispose pas d’un interrupteur secteur. Pour pla-
cer le Vx400 hors tension, déconnectez l’adaptateur secteur PS0913B de l’embase située en face arrière.

Système de sonorisation
Connectez le micro au Vx400. Connectez les sorties symétriques XLR Left et Right aux entrées de la
console en plaçant les panoramiques de voies à l’oposé. Sélectionnez le mode de sortie FULL. Consultez
la section sur les Modes de sortie en page 19 pour comprendre comment vous pouvez configurer les
sorties XLR et Jack 6,35 mm selon vos applications de scène ou d’enregistrement.

Configuration d’enregistrement
Configuration d’enregistrement type utilisant les entrées ligne et micro du RPx400 et une paire de moni-
teurs connectés aux sorties XLR du RPx400. Cette configuration peut également être utilisée sur scène :
vous pouvez jouer sur un accompagnement fourni par le logiciel Pro Tracks. Consultez la section sur les
Modes de sortie en page 19 pour comprendre comment vous pouvez configurer les sorties XLR et
Jack 6,35 mm selon vos applications de scène ou d’enregistrement.
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Mise sous tension
Avant toute mise sous tension de vos équipements, réglez l’égalisdation de votre console à plat..
1. Placez les Faders généraux de la console au minimum.
2. Connectez l’adaptateur secteur PS0913B en face arrière du processeur.
3. Reliez l’adaptateur à une prise secteur.
4. Réglez le volume général du Vx400 (Master Volume) sur 70 (70).
5. Montez les Faders généraux de la console en fonction du niveau souhaité.
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Les Presets
Les Presets sont des emplacements mémoires avec un nom et un numéro permettant la sauvegarde des sons
du Vx400. Le Presets sont rappelés par les pédales. Les effets actifs dans chaque Preset sont indiqués par les
Leds allumées du tableau d’effets. Le Vx400 dispose de 40 Presets utilisateur (Presets 1-40) et de 40 Presets
usine DigiTech (41-80). Les Presets utilisateur sont des emplacements où vous pouvez sauvegarder vos édi-
tions.Vous ne pouvez pas sauvegarder vos éditions dans les Presets usine. D’usine, les 40 Presets utilisateur
sont la copie des 40 Presets usine.

Mode de jeu
Lorsque vous placez le Vx400 sous tension pour la première fois, vous êtes en mode de jeu normal. Ce mode
vous permet d’accéder à tous les Presets du Vx400 par les pédales Haut/Bas. Le bouton 1 (gauche) règle les
graves,le bouton 2 (deuxième en partant de la gauche) règle le niveau des médiums. Le bouton 3 (au centre)
règle la fréquence des médiums. Le bouton 4 (deuxième en partant de la droite) règle les aigus. Le bouton 5
(à droite) règle le niveau général.

Bypass
Vous pouvez bypasser les Presets du Vx400 pour obtenir un son clair, non traité. Pour bypasser le Vx400,
appuyez sur la pédale BYPASS. L’écran affiche alors “Bypass”.Appuyez sur les pédales Haut ou Bas pour
changer de Preset.Appuyez à nouveau sur la pédale Bypass pour passer au Preset sélectionné et quitter le
Bypass.

Accordeur
L’accordeur vous permet d'accorder ou de contrôler rapidement l’instrument connecté. Pour activer l’accor-
deur, maintenez les pédales Haut et bas enfoncées. L’écran affiche rapidement tuner. Jouez une note sur
l’instrument (jouez une harmonique sur la 12ème frette, ce qui est parfait pour les guitares). Les deux carac-
tères à droite de l’écran indiquent la note jouée. Les caractères de gauche indiquent si la note est trop basse
ou trop haute. Les flèches vers la gauche (<<<) indiquent que la note est trop haute et que vous devez la des-
cendre. Les flèches vers la droite (>>>) indiquent que la note est trop basse. Lorsque la note est juste, l’écran
affiche --><--.

En mode accordeur, vous pouvez modifier la note de référence d’accordage. Par défaut la note est 
La = 440 Hz (affiché sous la forme A=440).Tournez le bouton 1 pour sélectionner une autre référence.Vous
pouvez sélectionner A = Ab ,A = G et A = Gb. L'écran affiche rapidement la note de référence sélectionnée.

En mode accordeur, le signal de sortie est coupé. La pédale d’expression vous permet d’obtenir le signal en
sortie lors de l’accordage. Quittez l’accordeur en appuyant sur l’une des 3 pédales.

>>><<< A

Indique que la note 
est trop basse 

Indique que 
la note est trop 

haute
Indique la  
note jouée
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Fonction CD/Monitor In
La fonction CD In vous permet de connecter un lecteur de CD, MP3 ou cassette au Vx400 et de chanter ou
jouer sur l’accompagnement. Pour utiliser la fonction CD In :

1. Connectez la sortie casque de votre lecteur de MP3/CD/cassette à l’entrée CD/Monitor en utilisant un
câble stéréo en mini-Jack 3,5 mm.

2. Appuyez sur la touche Play de votre lecteur de MP3/CD/cassette. Le signal de votre lecteur de
MP3/CD/cassette est affecté aux sorties gauche, droite et casque de votre Vx400.

La fonction Monitor In peut également comme entrée d’acoute du mixage de la sortie de la carte son de
votre ordinateur.

Boîte à rythmes
La RPx400 dispose d’une boîte à rythmes avec plusieurs Patterns de batterie échantillonnés utiles pour tra-
vailler le jeu en rythme.Appuyez sur la touche Drums pour activer la boîte à rythmes (sauf en modes Store
ou Bypass). Lorsque la boîte à rythmes est active :

Le bouton 1 permet de sélectionner le Pattern de batterie :

Le bouton 2 détermine le tempo sur une plage de 40 bpm (40 battements par minute) à 240 bpm 
(240 battements par minute).
Le bouton 3 détermine le volume du Pattern sur une plage de 1 à 99.
Appuyez à nouveau sur la touche Drums pour arrêter la lecture de la boucle de batterie.

Entrée Mic et Level
Le Vx400 dispose d’une entrée micro pouvant être utilisée pour l’enregistrement ou le mixage des chants et
des instruments acoustiques. L’entrée micro est équipée d’une alimentation fantôme pour vos micros à
condensateur professionnels. Le gain du préampli micro est contrôlé par le bouton Mic Level. Pour régler le
niveau d'entrée, opérez comme suit :

1. Connectez un casque à la sortie correspondante.
2. Chantez ou jouez avec le volume maximum et réglez le bouton Mic Level jusqu’à ce que la Led Clip située

en haut du tableau d’effets s’allume. Diminuez progressivement le réglage, jusqu’à ce que la Led s’éteigne.
Ceci correspond au réglage optimum du niveau Mic Level.

Pour les applications utilisant l’entrée micro, consultez les chapitres Connexions et Configurations du
Vx400 de ce mode d’emploi.

ROCK 1

ROCK 2

ROCK 3

HROCK1

HROCK2

HROCK3

HROCK4

POP1

POP2

POP3

POP4

POP5

DANCE1

DANCE2

DANCE3

cntry1

cntry2

blues1

blues2

jazz

funk 1

funk 2

swing1

swing2

urban1

urban2

reggae

cha 1

cha 2

BOSSA 

mtrnom
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Création de Presets
Édition/création de Presets
La création de vos propres sons est très simple. Le Vx400 vous permet de créer vos propres Presets et de
modifier les Presets existants selon vos besoins. Lorsque vous créez ou éditez un son, vous devez commen-
cer par l’un des Presets User ou Usine. Il n’est pas possible de commencer par un Preset vide. Le numéro du
Preset n’a pas besoin d’être le même que celui sous lequel vous souhaitez sauvegarder le nouveau Preset.
Vous pouvez utiliser n’importe quel Preset utilisateur pour la sauvegarde.

Pour éditer ou créer un Preset :
1. Utilisez les pédales Haut ou Bas pour sélectionner un Preset.
2. Une fois que vous avez trouvé un Preset que vous souhaitez éditer, appuyez sur la touche Select pour

passer en mode d’édition.
3. Utilisez la touche Select avec les Leds du tableau pour sélectionner l’effet que vous souhaitez éditer.

Appuyez à plusieurs reprises sur la touche Select pour faire défiler les effets du tableau.
4. Utilisez les boutons 1-4 pour modifier les valeurs de paramètres.
5. Enregistrez votre Preset (voir plus bas dans cette page).

Tableau d’effets
Le tableau d'effets vous permet d’identifier les effets et paramètres sélectionnés pour l’édition. En mode
d’édition, appuyez à plusieurs reprises sur la touche Select pour passer à la rangée suivante d’effets. Les Leds
indiquent quel groupe est sélectionné. Chaque groupe d’effets offre un maximum de 4 paramètres que vous
pouvez modifier. Le bouton situé directement sous chaque colonne permet de modifier la valeur du para-
mètre sélectionné. Lorsque vous tournez un bouton, le nom du paramètre et sa valeur ou le statut est affiché
à l’écran. Lorsque vous modifiez la valeur enregistrée d’un paramètre, la Led Store s’allume, vous indiquant
que vous devez sauvegarder les modifications. Le fait de changer de Preset ou de placer le processeur hors
tension avant la sauvegarde vous fait perdre vos nouveaux réglages.

Sauvegarder/Copier/Nommer un Preset
Une fois le Preset modifié, vous pouvez sauvegarder vos réglages dans l’un des 40 Presets utilisateur (Presets
1-40). Les étapes de la page suivante décrivent la procédure de sauvegarde des modifications d’un Preset ou
de copie d’un Preset dans un emplacement différent.

1. Appuyez une fois sur la touche Store. La Led de la touche Store clignote et le premier caractère de
l’écran clignote, indiquant que vous pouvez nommer votre nouveau Preset.

LO-FI  17

Chaque bouton règle la colonne des paramètres affichée  
directement au-dessus du bouton

Utilisez la touche Select 
pour sélectionner l'effet
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2. Utilisez le bouton 1 ou les pédales Haut/bas pour sélectionner le caractère alpha-numérique.
3. Tournez le bouton 2 vers la droite pour sélectionner le caractère suivant et vers la gauche pour sélec-

tionner le caractère précédent. Répétez l’étape 2 jusqu’à saisir le nom entier.

4. Une fois le nom affiché à l’écran, appuyez sur la touche Store. L’écran affiche alternativement le nouveau
nom et le nom du Preset qui va-t-être remplacé.

5. Sélectionnez l’emplacement du Preset utilisateur cible de votre nouveau Preset en utilisant le bouton 5
ou les pédales Haut/bas. L’écran continue d'afficher alternativement le nom du nouveau Preset et le nom
du Preset à remplacer.

6. Appuyez à nouveau sur la touche Store pour sauvegarder les modifications.

Appuyez sur la touche Select ou Drums pour annuler l’opération.

Pour copier un Preset sur une autre destination, c’est la même chose. Utilisez les pédales pour sélectionner
le Preset que vous souhaitez copier et reprenez les étapes mentionnées ci-dessus.

5. Sélectionnez le numéro de destination 
avec les pédales ou le bouton 5.

4. Appuyez à nouveau sur Store.
Le nom et le numéro du Preset 
clignotent à l'écran. 

1.  Appuyez sur Store et
les caractères clignotent

3.  Le bouton 2 sélectionne le
caractère précédent 
ou suivant à l'écran

2.  Le bouton 1 sélectionne 
les caractères alpha-
numériques
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Effets du Vx400
À propos des effets
Le Vx400 offre plusieurs simulations de micros ainsi que plusieurs Racks d’effet dans un seul boîtier program-
mable. L'ordre dans lequel vous insérez les pédales peut modifier radicalement le son final. Les effets du
RPx400 sont placés dans un ordre vous offrant le meilleur résultat sonore.Voici l’ordre des effets :

Définition des effets
Chaque effet du Vx400 peut être programmé selon vos goûts personnels et vos applications. La compréhen-
sion du fonctionnement de ces effets et de leurs paramètres vous aidera à obtenir le son recherché.

Modélisation de micros
Grâce à des algorithmes créés par DigiTech, nous avons pu recrééer des modèles précis de micros
célèbres. Cette technologie vous permet de créer un modèle composite de micro en retirant les carac-
téristiques typiques d’un micro dynamique ou à condensateur et en lui ajoutant les caractéristiques
sonores du micro souhaité.

Modeling On/Off — Le bouton 1 active (On) l’effet de modélisation ou le désactive (Of).
Source Mic — Le bouton 2 sélectionne le type de micro source : dynamique (dynamc) ou condensateur
(conden).
Modeled Mic - Le bouton 3 sélectionne le type de micro cible. Consultez le tableau ci-dessous :

Description/nom affiché du modèle 

Micro Description Nom affiché
AKG™ 414 TLII Condensateur à grand diaphragme GLDGRL

Neumann™ U87 AI Condensateur à grand diaphragme BIG 87

AKG™ C12 Tube à grand diaphragme TUBE

Oktava™ Condensateur à petit diaphragme PENCIL

Shure™ SM58 Dynamique à petit diaphragme 58 DYN

Royer™ 121 Micro à ruban RIBBON

Mic Model
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Shure™ Green Bullet Dynamique à grand diaphragme — BULLET

micro harmonica 
Brawner™ VM1 Condensateur à grand diaphragme BRAWNY

Neumann™ M149 Condensateur à grand diaphragme NEU149

Lawson™ L47MP Tube à grand diaphragme LAWLES

AKG™ 414 ULS Condensateur à grand diaphragme SLVGRL

Sennheiser™ 421 MD Dynamique à grand diaphragme SENDYN

Audio Technica™ AT4050 Condensateur à grand diaphragme ATCOND

Neumann™ KM184 Condensateur à grand diaphragme NEU184

Scheops™ MK21 Condensateur à petit diaphragme SHEP21

Shure™ KSM32 Condensateur à grand diaphragme KISSEm

Shure,AKG,Audio Technica, Neumann, Lawson, Oktava, Royer, Brawner, Sennheiser et Scheops sont des marques déposées par leurs sociétés mère. Les noms et marques mentionnés sont utilisés unique-
ment pour décrire le type de micro modélisé. Ces fabricants ne sont pas associés à DigiTech.

Compresseur/Noise Gate
Le module Compressor/Noise Gate permet de contrôler la dynamique des signaux variables et d’éliminer
les bruit des fond en abscence de signal.

Comp On/Off — Le bouton 1 active le compresseur (On) et le désactive (Of).
Amount — Tournez le bouton 2 pour régler le taux de compression appliqué au signal. Plage de 1 à 20.
Gain — Tournez le bouton 3 pour augmenter le gain de sortie du compresseur Plage de 0 à 10 dB.
Gate Off/Threshold — Tournez le bouton 4 pour désactiver le Noise Gate (Of) et pour régler le niveau
de seuil. Plage de 1 à 99. Un réglage important nécessite un niveau de signal élevé pour ouvrir le Noise
Gate.

Mic Pre/Voice
Ce module sélectionne divers types de préampli micro et de caractères de voix.Tube Pre est un préampli
micro professionnel au son chaud pour les chants standards. Les modèles Overdrive et Grunge sont des
préamplis saturés. Les 9 autres caractères de voix produisent des sont de voix avec beaucoup d’effet.

Voice Type/Off — Le bouton 1 sélectionne un type de chant et active les types Mic Pre/Voice (On) ou les
désactive (Of) (Voir le tableau de paramètres de types Mic Pre/Voice Type ci-dessous).
Paramètre 1 — Le bouton 2 règle le premier paramètre du type de voix sélectionné (voir le tableau des
paramètres Voice ci-dessous).
Paramètre 2 — Le bouton 3 règle le second paramètre du type de voix sélectionné (voir le tableau des
paramètres Voice ci-dessous).
Level — Le bouton 4 détermine le niveau du type sélectionné. PLage de 0 à 99
Master Level — Le bouton 5 contrôle le niveau général du Vx400.

Paramètres Mic Pre/Voice 
Type de voix Param 1 Plage Param 2 Plage
Direct ---- ---- ------ ----

Tube Pre Gain 0-15 De Ess 1-50
Overdrive Gain 0-50          De Ess 1-50
Grunge Gain 0-50          De Ess 1-50
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Dark Side Breath 1-20 ------ ----

Monster Size 1-60 Growl 1-40
Chipmunk Size 1-30 ------ ----

Lunar Range 1-10 ------ ----

Lo-Fi drive 0-50 Subfrq (Sub Freq.) 1-18
Robot Range 1-50 EdGE 1-50
Wizard Range 1-50 ------ ----

Alien RaTE 1-40 Intens (Intensité) 1-50
Telephone SubFRQ (Sub Freq.) 1-35 siblnc (Sibilance) 1-50

EQ
Le module d’égalisation à 3 bandes permet de régler les basses, médiums et aigus. La fréquence de chaque
filtre varie en fonction du modèle sélectionné.
Bass — Le bouton 1 règle le gain du filtre basse fréquence. ¨PLage de -12 à +12 dB.
Midrange — Le bouton 2 règle le gain du filtre médium. Plage de -12 à +12dB.
Mid Frequency — Le bouton 3 détermine la fréquence du filtre médium. Plage de 100 Hz à 4000 Hz.
Treble — Le bouton 1 règle le gain du filtre haute fréquence. ¨PLage de -12 à +12 dB.

Effets de modulation
Les effets du Vx400 offrent un module multifonction vous permettant de sélectionner les effets de
Chorus, Flanger, Phaser,Tremolo,Vibrato, Strobe, Doubleur, Enveloppe, Pixelator, Detune, Pitch Shifter et
Whammy™. Lorsque la rangée des effets est sélectionnée, le bouton 1 active les effets du module ou les
désactive (EFFECT OF) et sélectionne le type d’effet.Après avoir sélectionné le type d’effet du module, les
boutons 2-4 servent à régler les divers paramètres de chaque effet. Le bouton 5 règle le volume général
du Vx400.Voici une description des effets et de leurs paramètres :

Chorus
Le Chorus ajoute un délai très rapide à votre signal. Le signal retardé est modulé en phase et hors-
phase, puis il est re-mélangé avec le signal original pour créer un son plus épais.

Paramètre 1 — Le bouton 2 règle la vitesse de la modulation. Plage de 1 à 99.
Paramètre 2 — Le bouton 3 règle l’intensité (profondeur) de la modulation. Plage de 1 à 99.
FX Level — Le bouton 4 contrôle le volume du Chorus. Plage de 1 à 99.
Master Level — Le bouton 5 détermine le volume général du Vx400.

Flanger
Le Flanger reprend le principe du Chorus mais utilise un temps de retard plus court et ajoute une
réinjection (répétitions) à la modulation retardée. Il en résulte un mouvement de balayage extrême.

Paramètre 1 — Le bouton 2 règle  la vitesse de modulation. Plage de 1 à 99.
Paramètre 2 — Le bouton 3 règle  l’intensité (profondeur) de la modulation. Plage de 1 à 99.
FX Mix — Le bouton 5 contrôle le mélange signal traité/non traité. Plage de 0 (non traité) à 99
(entièrement traité).
Master Level — Le bouton 5 détermine le volume général du Vx400.
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Phaser
Le Phaser sépare le signal en deux canaux — un déphasé et l’autre normal. Le signal déphasé et alors
mélangé au signal original.Avec la modulation du déphasage, certaines fréquences sont annulées, ce qui
donne cet effet de mouvement au son.

Paramètre 1 — Le bouton 2 règle la vitesse de la modulation du déphasage. Plage de 1 à 99.
Paramètre 2 — Le bouton 3 règle l’intensité (profondeur) de la modulation. Plage de 1 à 99.
FX Level  — Le bouton 4 règle le niveau de l’effet de Phaser. Plage de 0 (signal non traité) à 99.
Master Level — détermine le volume général du Vx400.

Tremolo
L’effet de Tremolo module le volume du signal avec une vitesse constante.

Paramètre 1 — Le bouton 2 règle la vitesse de variation du volume. Plage de 1 à 99.
Paramètre 2 — Le bouton 3 règle  l’intensité (profondeur) de modulation du volume. Plage de 0 (signal non traité) à
99.
Le bouton 4 est inopérant lorsque l’effet Tremolo est sélectionné.
Master Level — Le bouton 5 détermine le volume général du Vx400.

Vibrato
Le Vibrato module la hauteur du signal d’entrée avec une vitesse constante.

Paramètre 1 — Le bouton 2 règle la vitesse de modulation de la hauteur. Plage de 1 à 99.
Paramètre 2 — Le bouton 3 règle l’intensité (profondeur) de l’effet. Plage de 0 (signal non traité) à 99.
Le bouton 4 est inopérant lorsque l’effet Vibrato est sélectionné.
Master Level — Le bouton 5 détermine le volume général du Vx400.

Strobe
L’effet Strobe est un tremolo utilisant une forme d’onde carrée de LFO pour moduler le signal.

Paramètre 1 — Le bouton 2 règle la vitesse de modulation de la hauteur. Plage de 1 à 99.
Paramètre 2 — Le bouton 3 règle l’intensité (profondeur) de l’effet. Plage de 0 à 99.
Le bouton 4 est inopérant lorsque l’effet Strobe est sélectionné.
Master Level — Le bouton 5 détermine le volume général du Vx400.

Doubler
L’effet de Doubler ajoute un signal légèrement retardé au signal d’entrée, créant un son plus épais.

FX Level — Le bouton 4 contrôle le volume du signal doublé. Plage de 0 (signal non traité) à 99 (signal
entièrement traité).
Les boutons 2 et 3 sont inopérants lorsque l’effet Strobe est sélectionné.
Master Level — Le bouton 5 détermine le volume général du Vx400.
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Envelope  

L’effet Envelope est une Wha automatique qui modifie votre son en fonction de l’attaque du chant ou
de l’instrument.

Paramètre 1 — Le bouton 2 règle le niveau du balayage de la Wah une fois la Wah déclenchée. Plage
de 1 à 99.
Paramètre 2 — Le bouton 3 règle règle la sensibilité ou le niveau du signal d’entrée requis pour
déclencher l’effet Wah. Plage de 1 à 99.
FX Mix — Le bouton 4 contrôle le mélange signal traité/non traité. Plage de 0 (non traité) à 99 (entiè-
rement traité).
Master Level — Le bouton 5 détermine le volume général du Vx400.

Pixelator
L’effet Pixelator retire des échantillons du signal d’entrée de façon aléatoirte, ce qui réduit la qualité
du signal d’entrée et rend le son granuleux. Plus la valeur est élevée plus le nombre d’échantillons sup-
pripmés est important, ce qui réduit la qualité sonore.

Paramètre 1 — Le bouton 2 règle le nombre aléatoire d’échantillons retirés du signal d’entrée. Plage
de 1 à 50.
Paramètre 2 — Le bouton 3 détermine où l’échantillon est retiré. Plage de 0 à 99.
FX Mix — Le bouton 4 contrôle le mélange signal traité/non traité. Plage de 0 (non traité) à 99 (entiè-
rement traité).
Master Level — Le bouton 5 détermine le volume général du Vx400.

Detune
L’effet Detuner désaccorde légèrement le signal et le mélange avec le signal d’entrée. Il en résulte un
effet comme si deux chants jouaient ensemble.

Paramètre 1 — Le bouton 2 règle la différence de hauteur appliquée au signal. Plage de -24 à 24.
FX Level — Le bouton 4 contrôle le volume de la note désaccordée. Plage de 0 à 99.
Le bouton 3 est inopérant lorsque l’effet Detune est sélectionné.
Master Level — Le bouton 5 contrôle le niveau général du Vx400.

Pitch Shifter 
L’effet Pitch Shifter transpose la note d’entrée. La note transposée est alors mélangée à la note initia-
le, créant une harmonisation du chant.

Paramètre 1 — Le bouton 2 sélectionne l’intervalle de transposition. Plage de -24 (24 demi-tons en
dessous de la note de départ) à 24 (24 demi-tons au-dessus de la note de départ).
Fx Level — Le bouton 4 contrôle le volume de la note transposée. Plage de 0 à 99.
Le bouton 3 est inopérant lorsque l’effet Pitch Shift est sélectionné.
Master Level — Le bouton 5 contrôle le niveau général du Vx400.
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Whammy™
L’effet Whammy™ utilise la pédale d’expression pour modifier progressivement la hauteur du signal d’en-
trée, ou pour ajouter une harmonie glissée au signal initial. La hauteur de la note glisse progressivement
vers le haut ou vers le bas avec le mouvement de la pédale. L’effet Whammy™ doit être lié à la pédale
d’expression pour fonctionner (voir page 16, sur l’utilisation de la pédale d’expression).

Paramètre 1 — Le bouton 2 sélectionne l’intervalle et la direction de la transposition. Les choix sont
les suivants :

Fx  Level — Le bouton 4 règle le volume de la Whammy™. Plage de 0 à 99.
Le bouton 3 est inopérant lorsque la Whammy™ est sélectionnée.
Master Level — Le bouton 5 contrôle le niveau général du Vx400.

Remarque :Vous ne pouvez utiliser qu’un seul effet de la rangée Effects à la fois.

Delay 
Le Delay est un effet de répétition retardée du signal d’entrée. La répétition peut être unique, multiple ou
infinie (ce qui coupe l’entrée du délai et vous permet de jouer sur un passage de la boucle de délai).

Delay Type/Off — Le bouton 1 active (On) et désactive (OF) le délai et sélectionne l’un des 3 différents
types de délai : DIGTAL (Digital Delay), ANALOG (Analog Delay), P PONG (Ping Pong).
Delay Time — Le bouton 2 règle le temps de retard. Plage de 10 MS à 2 Sec (10 ms à 1 seconde, par
pas de 10 ms, et de 1 seconde à 2 secondes par pas de 100 ms).
Feedback — Le bouton 3 règle le nombre de répétitions. Plage de 1 à 99 et répétition infinie.
Delay Level — Le bouton 4 règle le volume du signal du délai. Plage de 0 à 99.
Master Level — Le bouton 5 contrôle le niveau général du Vx400.

Reverb 
L’effet Reverb procure à l’auditeur une sensation d’environnement acoustique réglable.Vous pouvez choi-
sir l’environnement étroit d’une petite pièce ou un stade de Football.

Reverb Type/Off — Le bouton 1 sélectionne le type de réverbération ou d’environnement acoustique. Il
active (On) et désactive (OF) également l’effet. Le Vx400 offre un choix de huit environnements différents :

Whammy (pas de signal non traité)
1OCTUP (1 octave au-dessus) 
2OCTUP (2 octaves au-dessus)
2NDDWN (1 seconde inférieure)
REV2ND (1 seconde inf., pédale inversée)
4THDWN (Quarte inférieure)
1OCTDN (1 octave inférieure)
2OCTDN (2 octaves inférieures)
DIVBOM (Dive Bomb)

Harmonisation (avec signal non traité)
M3>MA3 (Tierce majeure à tierce majeure)
2NDMA3 (Seconde inf. à tierce majeure sup.)
3RD4TH (Tierce inf. à quarte sup.)
4TH5TH (Quarte sup. à quinte sup.)
5THOCT (Quinte sup. à une octave sup.)
HOCTUP (1 octave supérieure)
HOCTDN (1 octave inférieure)
OCTU>D (1 octave sup. à 1 octave inf.)
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Decay — Le bouton 2 règle la durée de la réverbération. Plage de 1 à 99.
Damping — Le bouton 3 contrôle le niveau du signal absorbé par l’environnement simulé. Plage de 0 à
99.
Reverb Level — Le bouton 4 règle le volume de la réverbération. Plage de 0 à 99.
Master Level — Le bouton 5 contrôle le niveau général du Vx400.

Pédale d’expression
La pédale d’expression du Vx400 peut être assignée pour contrôler au pied le volume, la Whammy™, ainsi
qu’à peu près tous ses paramètres en temps réel. Lorsque un paramètre est assigné à la pédale d’expres-
sion, une valeur programmable minimum et maximum est également assignable. La procédure d’assigna-
tion d’un paramètre à la pédale d’expression est la suivante :
1. Sélectionnez un Preset utilisateur ou usine.
2. Appuyez sur la touche SELECT jusqu’à sélectionner la rangée Expression (indiqué par la Led allumée

dans la rangée Expression).
3. Tournez le bouton 1 pour sélectionner la pédale d’expression 1,2 ou 3.
Remarque :Vous pouvez assigner trois paramètres par Preset à la pédale d’expression.

4. Tournez le bouton 2 pour sélectionner le paramètrecontrôlé par la pédale.
5. Tournez le bouton 3 pour sélectionner la valeur minimum atteinte par le paramètre lorsque la pédale
d’expression est en position haute.
6. Tournez le bouton 4 pour sélectionner la valeur maximum atteinte par le paramètre lorsque la pédale

d’expression est en position basse 
7. Appuyez sur la touche STORE pour sauvegrader les modifications.Voir en page 8 pour obtenir de
plus amples détails sur la sauvegarde des Presets.
Les paramètres contrôlables par la pédale d’expression sont les suivants :
(Les paramètres Voice et Effect dépendent du type sélectionné).

Paramètre Affiché Valeur mini. Valeur maxi.
Voice Param 1 Varies Varies Varies
Voice Param 2 Varies Varies Varies
Voice Level VOXLVL 1 99
Effect Speed param 1 Varies Varies
Amount/Depth Param 2 Varies Varies
Effect Level FXLEVL 0 99
Effect Mix FX MIX 0 99
Whammy WHMAMT 1 99
Delay Feedback FBACK 1 99 R-hold
Delay In Level DLY IN 0 99
Delay Out Level DLY OUT 0 99
Reverb Decay DECAY 1 99
Reverb In Level Rvb IN 0 99
Reverb Out Level RVbOUT 0 99
Volume Pre VOLPRE ----- -----
Volume Post VOLPST ----- -----

HALL = Hall
PLATE = Plaque  
ROOM = Pièce avec murs en bois
CHAMBER = Chambre 

GARAGE = Garage
CHURCH = Église
ARENA = Stade
SPACE = Espace
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Commutateur virtuel V-Switch

La pédale d’expression du RPx400 dispose du commutateur virtuel DigiTech V-Switch. Le V-Switch permet
d’activer ou de désactiver le paramètre Voice Type Appuyez avec l’avant du pied sur la pédale d’expression
pour activer le V-Switch. La fonction de la pédale d’expression passe du paramètre assigné à Voice Off. La
sensibilité ou la pression nécessaire au déclenchement du V-Switch est réglable (selon vos goûts ou le
poids de votre pied).Voir page 32, sur la procédure de réglage de la sensibilité du V-Switch.
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Introduction aux configurations
Le Vx400 est équipé de quatre entrées et de quatre sorties que vous pouvez configurer de différentes façons
pour la scène ou l’enregistrement. Ces configurations sont sélectionnées dans la rangée DRUMS/SETUP du
tableau à l’aide des cinq boutons d’édition.Vous pouvez choisir si les entrées Mic ou Line sont routées aux
effets du Vx400 et à quelle paire de sorties le traitement du micro, de l’entrée ligne, ou de l’entrée iinstru-
ment doit être affecté. Les touches USB 1-2 Source et USB 3-4 Source servent à configurer comment
toutes les entrées, le traitement micro et la boîte à rythme sont routés par liaison USB à l’ordinateur pour
l’enregistrement.

Configurations Instrument/Ligne
Les configurations Instrument et Line sont prévues principalement pour la scène. Le Vx400 sert de mixa-
ge pour les sources micro, instrument et ligne. Ceci peut vous éviter d’avoir à utiliser un mélangeur,
lorsque les sorties du Vx400 sont connectées directement à des enceintes amplifiées. Ces entrées peu-
vent être routées avec ou sans traitement par les effets du VPx400, puis mélangées directement aux sor-
ties Jack 6,35 mm et XLR du Vx400.

Les entrées Instrument et Line offrent quatre réglages que vous pouvez sélectionner séparément par les
boutons Instrument et Line de la rangée DRUMS/SETUP du tableau d’effets. Les configurations sont
les suivantes :

InsOFF / LINOFF — Entrées Instrument et Line désactivées.
insDRY / LINDRY — Entrées routées directement aux sorties du Vx400, sans effets.
insRVB / LINRVB — Entrées affectées aux effets de délai et de réverbération du Preset courant.
insFX / LINEFX — Entrées affectées à tous les effets du Preset courant.

Routage de l’entrée instrument 

Routage de l’entrée ligne

Line Left

Line Right

+

Line = linefx Line = linrvb Line = lindry

Mic
Model Comp  EQ

Noise
Gate Effects Delay Reverb

+ +Mic Pre
Voice

+

+

+

+

Sortie XLR gauche
Sortie XLR droite

Sortie Jack gauche
Sortie Jack droite

Entrée Instrument
Instrument = insfx

  Mic   
Model Comp Mic Pre

Voice
EQ

Noise
Gate Effects Delay Reverb

+

+

+

+

+

+

Instrument = insrvb Instrument = insdry

Sortie XLR gauche
Sortie XLR droite

Sortie Jack gauche
Sortie Jack droite

18

Vx400 — Configurations



Modes de sortie
Le Vx400 dispose de sorties en Jacks 6,35 mm et en XLR. Ces connecteurs vous permettent de connec-
ter le Vx400 simultanément à un système d’amplificateur/enceintes sur scène par les sorties
Jacks 6,35 mm et à votre sonorisation par les XLR.
Les cinq modes de sortie du Vx400 sont les suivants :

Full - Toutes les sources d’entrée sont routées aux sorties. Jack 6,35 mm et XLR.

XLRdry - Le signal non traité du micro est transmis uniquement par les sorties XLR. Toutes les autres
sources et le micro avec effets sont transmises par les sorties en Jack 6,35 mm.

XLRMOD - Le signal du micro avec les effets de modulation est transmis uniquement par les sorties XLR.
Toutes les autres sources et le micro avec effets sont transmises par les sorties en 
Jack 6,35 mm.

Line Right

Mic In

Instrument In

Line Left

Mic
Model Comp

Mic Pre
Voice

    DRUMS

EQ
Noise
Gate Effects Delay Reverb

+ +
+

+
+

Instrument = InsfX

Line = Linefx

Instrument = insrvb

Line = linrvb

Instrument = insdry

Line = lindry

Sortie XLR gauche
Sortie XLR droite

Sortie Jack gauche
Sortie Jack droite

Line Right

Mic In

Instrument In

Line Left

Mic
Model Comp

Mic Pre
Voice

    DRUMS

EQ
Noise
Gate Effects Delay Reverb

+ +

+
+

+

Instrument = InsfX

Line = Linefx

Instrument = insrvb

Line = linrvb

Instrument = insdry

Line = lindry

Sortie XLR gauche
Sortie XLR droite

Sortie Jack gauche
Sortie Jack droite

Line Right

Mic In

Instrument In

Line Left

Mic
Model Comp

Mic Pre
Voice

    DRUMS

EQ
Noise
Gate Effects Delay Reverb

+ +

+

+

+

+
+

Instrument = InsfX

Line = Linefx

Instrument = insrvb

Line = linrvb

Instrument = insdry

Line = lindry

Sortie XLR gauche
Sortie XLR droite

Sortie Jack gauche
Sortie Jack droite
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1/4DRY - Le signal non traité du micro est transmis uniquement par les sorties en Jack 6,35 mm.Toutes
les autres sources et le micro avec effets sont transmises par les sorties XLR.

1/4MOD - Le signal du micro avec les effets de modulation est transmis uniquement par les sorties Jack
6,35 mm.Toutes les autres sources et le micro avec effets sont transmises par les sorties XLR.

Line Right

Mic In

Instrument In

Line Left

Mic
Model Comp

Mic Pre
Voice

    DRUMS

EQ
Noise
Gate Effects Delay Reverb

+ +
+

+
+

Instrument = InsfX

Line = Linefx

Instrument = insrvb

Line = linrvb

Instrument = insdry

Line = lindry

Sortie XLR gauche
Sortie XLR droite

Sortie Jack gauche
Sortie Jack droite

Line Right

Mic In

Instrument In

Line Left

Mic
Model Comp

Mic Pre
Voice

    DRUMS

EQ
Noise
Gate Effects Delay Reverb

+ +

+
+

+

Instrument = InsfX

Line = Linefx

Instrument = insrvb

Line = linrvb

Instrument = insdry

Line = lindry

Sortie XLR gauche
Sortie XLR droite

Sortie Jack gauche
Sortie Jack droite
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Introduction à l’enregistrement
La connexion USB du Vx400 offre simultanément 4 canaux audio vers l’ordinateur et 2 canaux de lecture
depuis l’ordinateur. L’enregistrement n’a jamais été plus simple, grâce à l’environnement “main-libre” offert par
l’utilisation du Vx400 et du logiciel Pro Tracks. L’utilisation des pédales du Vx400 et de Pro Tracks vous permet
d’armer, d’enregistrer, de lire et d’effacer automatiquement les pistes à la volée, sans avoir à quitter la guitare.
Des configurations d’enregistrements multiples peuvent être sélectionnées pour optimiser vos besoins d’en-
registrement. Ces configurations sont accessibles sur leVx400, par la rangée DRUMS/SETUP du tableau
d’effets.

Pour enregistrer, vous devez tout d’abord installer les Drivers USB et Pro Tracks sur votre ordinateur tour-
nant sous Windows. Les Drivers USB se trouvent sur le CD X-Edit fourni avec le Vx400. Le CD Pro Tracks
est dans la boîte Pro Tracks. Lisez le mode d’emploi de Pro Tracks pour vous assurer que votre ordinateur
offre les caractéristiques nécessaires avant l’installation et consultez le Guide d’installation logicielle
DigiTech. Une fois l’installation achevée, le Vx400 peut alors contrôler Pro Tracks et ses fonctions d’enregis-
trement.

Connexion du Vx400 à l’ordinateur
Le Vx400 est fourni avec son câble USB pour la connexion à l’ordinateur, pour l’enregistrement ou l’utili-
sation du logiciel d’édition et de gestion des Presets X-Edit. Nous conseillons de n’utiliser que le câble
USB fourni avec le RPx400. Pour connecter le Vx400 à l’ordinateur, procédez comme suit :

• Avant de connecter le port USB du Vx400 à l’ordinateur, consultez le Guide d’installation
logicielle DigiTech et suivez les instructions qui correspondent à votre système d’exploita-
tion.

1. Commencez avec le Vx400 hors tension.
2. Connectez la petite fiche du câble USB dans le port USB situé à l’arrière du Vx400.
3. Connectez la fiche plate du câble USB dans un port USB libre de l’ordinateur.
4. Placez le Vx400 sous tension.

Configuration du Vx400 pour l’enregistrement
Le Vx400 permet diverses configurations d’entrées/sorties, en fonction de vos besoins. Sélectionnez ces
configurations en utilisant les touches USB 1-2 Source et USB 3-4 Source du tableau d’effets. Il se
peut que pour une session donnée, vous ayez besoin d’enregistrer le micro avec les effets, sans effet, un
instrument, une entrée ligne, voire de retraiter vos pistes de chant non-traitées dans le Vx400.Vous pou-
vez transférer un maximum de 4 canaux audio simultanément à l’ordinateur. Les touches de la rangée
SETUP sélectionnent comment et quels signaux audio sont routés vers la connexion USB. Chaque sour-
ce USB affecte une paire de signaux à l’ordinateur. Voici comment ces signaux sont distribués :

USB 1-2 Source
STEREO — Toutes les sources d’entrée traitées par les effets du Vx400 sont transmises par USB 1 et 2.
MONO — Toutes les sources d’entrée traitées par les effets du Vx400 sont mélangées en mono et trans-

mises par USB 1.Aucune donnée n’est transmise par USB 2.
effect — Le signal des effets est tyransmis sur USB 1 et 2. Enregistrement de pistes stéréo.
SUM+DM — Toutes les sources d’entrée traitées par les effets du Vx400 sont mélangées en mono et trans-

mises par USB 1. Le micro non traitée est transmis par USB 2.
SUMins — Toutes les sources d’entrée traitées par les effets du Vx400 sont mélangées en mono et trans-

mises par USB 1. Le signal de l’instrument non traité est transmis par USB 2
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Dmic+i — Le signal du micro non traité est transmis par USB 1. Le signal de l’instrument non traité est
transmis par USB 2.

drymic —  Le signal du micro non traité est transmis par USB 1. Rien n’est transmis par USB 2.
DRYlin —  Le signal de l’entrée Ligne gauche est transmis par USB 1. Le signal de l’entrée Ligne droite

est transmis par USB USB 2. Enregistrement d’une piste stéréo.
DRYins —  Le signal de l’instrument non traité est transmis par USB 1. Rien n’est transmis par USB 2.
DRUMS —  Les rythmes sont transmis par USB 1. Rien n’est transmis par USB 2.
REmic —  La lecture de Pro Tracks est transmise de l’ordinateur dans les effets du Vx400 et ensuite ren-

voyée par USB 1 et 2 pour être enregistrée. Voir Traitement d’une piste chant en page 28.

USB 3-4 Source
USBOFF —  USB 3 et 4 désactivés.
Dmic+i —  Signal micro non traité transmis par USB 3. Instrument non traité transmis pas USB 4.
drymic —  Signal micro non traité transmis par USB 3. Rien n’est transmis par USB 4.
DRYlin —  Signal ligne gauche non traité transmis par USB 3. Signal ligne droit non traité transmis par

USB 4.
DRYins —  Signal instrument non traité transmis par USB 3. Rien n’est transmis par USB 4.
DRUMS —  Les rythmes du Vx400 sont transmis par USB 3. Rien n’est transmis par USB 4.

Les illustrations des pages suivantes vous indiquent comment les signaux sont distribués par la liaison
USB pour l’enregistrement :

Affectation du signal micro
Le signal du micro est routé de l’entrée aux effets du Vx400, puis aux paires de sorties. Le signal transmis
par USB peut être prélevé à l’entrée (USB Send A), ou en sortie des effets (USB Send C ou D). Les
signaux enregistrés sans effet par USB Send A peuvent être traités plus tard par le Vx400. Voir
Traitement d’une piste chant en page 28..

Mic USB Source Mapping
Le signal du micro peut être routé de trois différentes façons vers le port USB. Le trajet A prélève le
signal du microdirectement en entrée et transmet le signal non traité au port USB. Le trajet C prélève le
signal après les modules d’effet, sans le délai et la réverbération. Le trajet D prélève le signal du micro en
sortie du Vx400 et peut comprendre les effets.Vous trouverez, en page suivante, un tableau vous indiquant
où le signal est prélevé, en fonctiond es réglages Mic, USB 1-2 Source et USB 3-4 Source.

Entrée micro Mic
Model Comp Mic Pre

Voice
EQ

Noise
Gate Effects Delay Reverb

USB Dry
Send 

A USB Re-Mic 
Return 

B USB Send C USB Playback 
Return 

EUSB Send D

Sortie XLR gauche
Sortie XLR droite

Sortie Jack gauche
Sortie Jack droite
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Routage du signal Instrument
Le signal Instrument peut être routé de différentes façons dans le Vx400. insoff désactive l’écoute de
l’entrée Instrument mais permet l’enregistrement du signal non traité de l’instrument. insdry route le
signal de l’instrument sans les effets du Vx400 et le mélange aux sorties. insrvb route le signal de l’ins-
trument uniquement traité par la réverbération et le délai du Vx400. insfx route le signal de l’instru-
ment dans tous les effets du Vx400.

Affectation USB de l’entrée Instrument 
Comme vous pouvez le constater dans l’illustration ci-dessus, le signal de l’entrée instrument peut être
transmis au port USB par deux chemins. Le chemin F prélève le signal de l’instrument directement en
entrée et transmet le signal non traité au port USB. Le trajet C prélève le signal de l’instrument en sor-
tie des modules d’effet, sans le délai et la réverbération. Le trajet D prélève le signal en sortie du Vx400
et peut comprendre les effets.Vous trouverez ci-dessous un tableau montrant où le signal est prélevé en
fonction des réglages Instrument, USB 1-2 Source et USB 3-4 Source.
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r
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C

insoff

insdry

insRVB

insFX

Inst.

USB 1-2 Source

F F F F F • • F • •
F F F F F • • F • •
D D D F F • • F • •
D D D F F • • F • •

e
f
f
e
c
t

F
F
D
C

Affectation de l'entrée Instrument au port USB
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d
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micoff

micdry

micRVB

MICFX

Inst.

USB 3-4 Source

• F • • F •
• F • • F •
• F • • F •
• F • • F •

Entrée Instrument
Instrument = InsfX Instrument = insrvb Instrument = insdry

Mic
Model Comp

Mic Pre
Voice EQ

Noise
Gate Effects Delay Reverb

+

+

+

+

+

+

+
Sortie XLR gauche
Sortie XLR droite

Sortie Jack gauche

Sortie Jack droite

USB Dry
Send 

F USB Send D USB Playback 
Return 

EUSB Send C
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Mic Mic
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D D A,D D A A • • • •

e
f
f
e
c
t

C

Affectation de l'entrée Mic au port de sortie USB
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Routage du signal des entrées ligne
Les signaux ligne, comme le signal dde l’instrument, peuvent être routés de diverses façon dans le Vx400.
linoff désactive l’écoute des entrées ligne, mais le signal non traité des entrées ligne peut être enregis-
tré. lindry route les signaux ligne gauche et droit sans les effets du Vx400 et les mélange aux sorties
gauche et droite. linrvb route les signaux ligne uniquement par les effets de délai et de réverbération
du Vx400. linefx mélange les voies gauche et droite des entrées ligne et affecte ce signal à tous les
effets du Vx400.

Line USB Source Mapping
Les signaux d’entrée ligne, comme nous l’avons vu dans le schéma de routage précédent, offrent deux tra-
jets de routage à l’ordinateur par le port USB. Le trajet G prélève le signal des entrées ligne directement
sur les entrées et transmet le signal non traité au port USB. Le trajet C prélève ces signaux en sortie des
modules d’effet, sans la réverbération et le délai. Le trajet D prélève le signal en sortie du Vx400 et peut
comprendre tous les effets disponibles.Voici un tableau montrant où le signal est prélevé en fonction des
réglages Line, USB 1-2 Source et USB 3-4 Source :
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LINoff

LINdry

LINRVB

E
F
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E
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LINeFX

Line

USB 1-2 Source

Affectation des entrées ligne au port de sortie USB

G G G G • G • • • •
G G G G • G • • • •
D D D D • D • • • •
D D D D • D • • • •

LINoff

LINdry

LINRVB

LINeFX

Line
G
G
D
C

Line Right

Line Left

Mic
Model Comp

Mic Pre
Voice EQ

Noise
Gate Effects Delay Reverb

+

+

+

+

+

+

+
Sortie XLR gauche
Sortie XLR droite

Sortie Jack gauche
Sortie Jack droite

USB Dry
Send 

G USB Send D USB Playback 
Return 

E

Line = Linefx Line = linrvb Line = lindry

USB Send C
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Utilisation de Pro Tracks
Lorsque vous lancez Pro Tracks pour la première fois après installation, vous devez configurer les réglages de
périphérique MIDI et audio pour que le Vx400 soit reconnu comme le périphérique à utiliser. Ces procédures
doivent être scrupuleusement suivies afin de pouvoir enregistrer les signaux audio du Vx400 et permettre
l’automatisation offerte par le Vx400.

REMARQUE : Consultez la fiche d’installation logicielle fournie avec le Vx400 (sur l’installation
des Drivers USB), avant de connecter le Vx400 à votre ordinateur et d’utiliser Pro Tracks.

Installation de Pro Tracks
Vous devez installer Pro Tracks sur votre ordinateur pour exploiter les possibilités d’enregistrement du
Vx400. Pour installer Pro Tracks, consultez les instructions d’installation fournies avec le CD d’installation
de Pro Tracks.

Configuration du système USB DigiTech
Le Vx400 utilise des commandes MIDI par USB pour communiquer avec Pro Tracks. Ces commandes sont
utilisées pour déterminer quels réglages USB 1-2 Source et USB 3-4 ont été sélectionnés, de sorte que
Pro Tracks puisse fonctionner correctement lorsque vous utilisez les commandes au pied du Vx400. Pour
configurer les réglages MIDI de Pro Tracks pour fonctionner avec le Vx400, procédez comme suit :

1. Lancez Start Pro Tracks sur votre ordinateur.
2. Si la fenêtre Tip of the Day s’affiche, cliquez sur le bouton Close.
3. Si aucune sortie MIDI n’a encore été sélectionnée, la fenêtre No MIDI Outputs Selected s’affiche.

Cliquez sur le bouton Choose MIDI Outputs Now. La fenêtre MIDI Devices s’ouvre.
4. Dans les zones Input et Output, sélectionnez DIGITECH USB CONTROL. Ne pas sélectionner

DigiTech USB X-Edit ou toute autre option. Cliquez sur le bouton Move Selected Devices to Top.
5. Cliquez sur le bouton OK — la fenêtre se ferme.
6. Si la fenêtre Quick Start s’ouvre, cliquez sur le bouton Close.

Configuration du Vx400 pour activer les commandes au pied
1. Depuis la barre de menus de Pro Tracks, sélectionnez Options>Control Surfaces. La fenêtre

Control Surfaces s’affiche.
2. Cliquez sur le bouton * pour ajouter un nouveau contrôleur. La fenêtre Control Surface Settings

s’ouvre.
3. Dans le menu déroulant Control Surface, sélectionnez DigiTech Hands-Free.Vérifiez que les

réglages de ports Input et Output indiquent toujours DigiTech USB CONTROL. Dans le cas
contraire, rectifiez.

4. Cliquez sur le bouton OK. Hands-Free doit maintenant être sélectionné comme contrôleur de la
zone Control Surfaces.

5. Cliquez sur le bouton Close.

Pro Tracks peut maintenant répondre au Vx400 pour les fonctions d’enregistrement automatisées.
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Configuration de Pro Tracks pour les signaux audio du Vx400
1. Dans la barre de menu de Pro Tracks, sélectionnez Options>Audio. Le fenêtre Audio Options s’af-

fiche. Cliquez sur l’onglet Drivers.
2. Dans les réglages Input Drivers, sélectionnez DigiTech USB 1-2 In/Out et DigiTech USB 3-4 In

Only et désélectionnez toutes les autres options.
3. Dans la zone Output Drivers, sélectionnez DigiTech USB 1-2 In/Out et désélectionnez toutes les

autres options.
4. Cliquez sur le bouton OK.
5. Cliquez sur le bouton OK de la fenêtre de sauvegarde des réglages lors du prochain démarrage.
6. Fermez Pro Tracks. Lorsque le logiciel vous demande de sauvegarder les modifications, cliquez sur No.
7. Relancez Pro Tracks.
8. Fermez les fenêtres Tip of the Day et Quick Start si elles apparaissent.
9. Dans la barre de menu de Pro Tracks, sélectionnez Options>Audio.

10. Vérifiez si les réglages Playback et Record Timing Master indiquent DigiTech USB 1-2 In/Out.
Sinon, sélectionnez-les maintenant.

11. Cliquez sur le bouton Wave Profiler (en bas).
12. Cliquez sur le bouton Yes pour continuer les tests.
13. Lorsque l’opération d’auto-test est terminée, cliquez sur le bouton OK.
14. Cliquez sur le bouton OK pour fermer la fenêtre Audio Options si elle est toujours ouverte.

Vous êtes maintenant prêt à utiliser le Vx400 avec Pro Tracks.

ATTENTION : Ne pas déconnecter l’alimentation ou le câble USB du Vx400 ou de l’ordina-
teur pendant que Pro Tracks tourne. Ceci pourrait déstabiliser le système d’exploitation de
votre ordinateur.
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Utilisation des pédales du Vx400 en enregistrement
Vous pouvez utiliser les pédales du Vx400 pour contrôler Pro Tracks™, ce qui vous permet d’enregistrer tout
en jouant.Vous devez relier le Vx400 à l’ordinateur par le câble USB fourni. Pro Tracks doit être installé et
tourner.

Enregistrement d’une ou plusieurs pistes
Pour enregistrer une piste en utilisant les pédales, procédez comme suit :

1. Lancez Pro Tracks.
2. Dans Pro Tracks, sélectionnez File>New. La fenêtre New Project File s’affiche.
3. Dans la fenêtre New Project File, sélectionnez Normal — Hands-Free Session.
4. Placez les pédales du Vx400 en mode d’enregistrement en maintenant les pédales HAUT et BYPASS

enfoncées, jusqu’à ce que l’écran affiche rec fs.
5. Dans l’écran des Presets, maintenez la touche SELECT enfoncée pour passer sur la rangée SETUP

du tableau des effets du Vx400. Sinon, appuyez sur la touche SELECT jusqu’à ce que la rangée Setup
soit sélectionnée.

6. Sélectionnez les sources à enregistrer à l’aide du bouton USB 1-2 Source (vous pouvez sélectionner
d’autres sources à l’aide de la touche USB 3-4 Source).

7. Appuyez sur la pédale RECORD. L’écran affiche record. Une ou plusieurs pistes sont
automatiquement insérées dans la session courante de Pro Tracks et l’enregistrement sur ces pistes
commence.

8. Pour arrêter l’enregistrement, appuyez sur la pédale STOP/UNDO. L’écran du Vx400 indique stop et
Pro Tracks cesse l’enregistrement.Vous pouvez maintenant consulter les pistes enregistrées sur votre
ordinateur.

Lecture d’une piste enregistrée
Si vous souhaitez lancer la lecture depuis le début de la piste ou du morceau, et si vous n’êtes pas à la fin
du morceau, procédez comme suit :

1. Appuyez sur la pédale STOP/UNDO. L’écran du Vx400 affiche rewind. Pro Tracks revient au début
du morceau.

2. Appuyez sur la pédale PLAY. Les pistes enregistrées sont lues.
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Enregistrement de plusieurs pistes
Vous pouvez enregistrer des pistes supplémentaires tout en écoutant les pistes déjà enregistrées.
Procédez comme suit :

1. Dans l’écran Preset, maintenez la touche SELECT enfoncée pour passer sur la rangée SETUP du
tableau d’effets du Vx400.

2. Sélectionnez les sources à enregistrer à l’aide de la touche USB 1-2 Source (vous pouvez
sélectionner d’autres sources à l’aide de la touche USB 3-4 Source).

3. Appuyez deux fois sur la pédale STOP/UNDO pour revenir au début du morceau.
4. Appuyez sur la pédale RECORD. L’écran affiche record. La, ou les pistes, sont automatiquement

insérées dans la session de Pro Tracks et l’enregistrement de ces pistes commence.
5. Pour arrêter l’enregistrement, appuyez sur la pédale STOP/UNDO.

Utilisation de la pédale UNDO pour effacer une piste
Vous pouvez annuler la dernière prise comme suit :

1. Maintenez la pédale STOP/UNDO enfoncée. Le Vx400 affiche undo, indiquant que la/les dernières
pistes enregistrées sont effacées.

Traitement post-enregistrement d’une piste de chant
En utilisant l’une des configurations de signal de micro non traité pour l’enregistrement, vous pouvez lire
la piste de chant non-traitée dans le Vx400 pour traitement. Ceci vous permet d’enregistrer le chant en
sans traitement et de décider lors du mixage des effets à lui appliquer (modèle de micro, effets, etc.). Ceci
vous permet d'adapter le son et le style du chant au morceau, une fois celui-ci terminé et prêt pour le
mixage final. Ceci vous évite d’avoir une piste de chant enregistrée avec les effets et de pouvoir décider
des effets à appliquer lors du mixage.

Pour traiter une piste de chant enregistrée sans effets :
1. Placez les pédales du Vx400 en mode d’enregistrement en maintenant les pédales HAUT et

BYPASS enfoncées, jusqu’à ce que l’écran affiche rec fs.
2. Dans Pro Tracks, sélectionnez File>New. La fenêtre New Project File s’ouvre.
3. Sélectionnez le fichier Normal-Hands Free Session.
4. Sélectionnez la rangée SETUP du tableau d’effets du Vx400.
5. Utilisez la touche USB 1-2 Source pour sélectionner dryMic et placez USB3-4 Source sur off.
6. Appuyez sur la pédale RECORD. L’écran du Vx400 affiche record. Une piste est automatiquement

insérée dans la session de Pro Tracks et l’enregistrement de cette piste commence.
7. Pour arrêter l’enregistrement, appuyez sur la pédale STOP/UNDO. Le Vx400 affiche stop et

l’enregistrement cesse.Appuyez à nouveau sur la pédale Stop pour revenir au début de la piste.
8. Dans la boîte Out de la piste que vous venez d’enregistrer, sélectionnez B (Digitech USB 1-2

In/Out).
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9. Dans la barre d’outils, appuyez sur Console View pour afficher la console de mixage.

10. Placez B — Mains Output complètement à gauche et A — Mains Output complètement à
droite.

11. Sélectionnez à nouveau la rangée SETUP et utilisez la touche USB 1-2 Source pour sélectionner
REMIC. Ceci configure le logiciel en lecture audio par les effets du Vx400.

12. Appuyez sur la pédale PLAY. Placez les pédales en mode de jeu normal en maintenant les pédales
UP et BYPASS enfoncées jusqu’à ce que l’écran indique updown. Vous pouvez maintenant écouter
les Presets jusqu’à en trouver un qui vous plaise. Repassez alors en mode d’utilisation des pédales
pour l’enregistrement.

13. Appuyez deux fois sur la pédale STOP/UNDO pour revenir en début de piste.
14. Appuyez sur la pédale RECORD — l’enregistreur insère et enregistre alors une piste stéréo de

chant traitée.
15. Pour arrêter l’enregistrement, appuyez sur la pédale STOP/UNDO.
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Vx400 Drums et MIDI
Les échantillons de la boîte à rythmes du Vx400 sont organisés de sorte que vous puissiez les déclencher
depuis les notes MIDI jouées par Pro Tracks. Chaque Pattern rythmique du Vx400 a été programmé comme
piste MIDI dans les fichiers de Pro Tracks.

Affectation MIDI des échantillons de batterie du Vx400 :
Note MIDI Échantillon
36/C3  . . . . . . . . . . . . .Grosse caisse
38/D3  . . . . . . . . . . . . .Caisse claire
42/F#3  . . . . . . . . . . . .Charleston fermé
46/Bb3  . . . . . . . . . . . .Charleston ouvert

Enregistrement des sons de la boîte à rythmes du Vx400
Les sons de la boîte à rythmes du Vx400 peuvent être enregistrés par Pro Tracks. Chaque Pattern ryth-
mique du Vx400 a été sauvegardé dans un fichier que vous pouvez sélectionner avec l’assistant bibliothé-
caire de Pro Tracks et que vous pouvez utiliser pour lire ces échantillons dans le Vx400. Pour enregistrer
les sons de batterie du Vx400 en utilisant les fichiers de Pattern de Pro Tracks, procédez comme suit :

1. Dans Pro Tracks, sélectionnez File>New. La fenêtre New Project File s’affiche.
2. Sélectionnez l’un des fichiers de Pattern DigiTech Vx400 et cliquez sur OK. Une nouvelle session

d’enregistrement s’ouvre.
3. Sur le Vx400, utilisez les touches USB 1-2 Source ou USB 3-4 Source pour sélectionner drums.
4. Appuyez sur la pédale RECORD. Le Vx400 affiche record. Une nouvelle piste est automatiquement

insérée dans la session courante de Pro Tracks et l’enregistrement sur ces pistes commence.
5. Pour arrêter l’enregistrement, appuyez sur la pédale STOP/UNDO.

Vous pouvez utiliser des fichiers MIDI de Patterns de batterie pour déclencher les sons du Vx400, tant
que les notes MIDI sont organisées pour déclencher les bons corrects. Les sons de batterie du Vx400
répondent uniquement aux messages MIDI transmis sur le canal 10, qui est le canal par défaut des fichiers
au format General MIDI.

Mixage de la lecture
Le bouton PLAYBACK MIX vous permet de mixer facilement le traitement du Vx400 avec la lecture des
pistes de Pro Tracks. Cette fonction est uniquement disponible lorsque le Vx400 est connecté à l’ordinateur
par liaison USB et que Pro Tracks est chargé. Pour modifier le niveau de lecture du Vx400, procédez comme
suit :

1. Lancez la lecture de la session sur Pro Tracks.
2. Tournez le bouton Playback Mix pour équilibrer le niveau de traitement de la guitare du Vx400 avec la lec-

ture. Lorsque l’écran indique USBMIX 0 cela signifie que seuls les signaux du Vx400 peuvent être enten-
dus.Tournez le bouton vers la droite pour augmenter le niveau de la lecture. USB VX50 indique que le
niveau Vx400/son de l’ordinateur est réglé sur 50/50.Tournez encore vers la droite pour diminuer le
niveau du Vx400. Vx MIX 0 indique que seule la lecture de l’ordinateur est entendue.
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Boutons USB 1-2 Level / USB 3-4 Level
Les boutons USB 1-2 LEVEL et USB 3-4 LEVEL servent à doser le niveau des signaux transférés à l’ordi-
nateur par le port USB. Ces réglages sont utilisés lorsque le niveau du signal de la source d’entrée (micro,
ligne, guitare) n’est pas optimisé dans votre logiciel d’enregistrement (consultez le mode d’emploi de Pro
Tracks pour obtenir de plus amples renseignements sur les réglages de niveau). Si le niveau du signal est trop
élevé pour Pro Tracks, utilisez ces réglages pour diminuer le niveau. Les boutons USB 1-2 Level et USB 3-4
Level contrôlent le niveau de chaque paire de sorties USB. Par exemple, si summic est la source USB 1-2
Source sélectionnée, le fait d’augmenter le niveau du micro de 6 dB sur la sortie USB 2 augmente également
le niveau total de 6 dB sur la sortie USB 1. Pour augmenter ou atténuer le niveau du signal audio transféré à
l’ordinateur, procédez comme suit :

1. Jouez ou chantez dans le Vx400 et contrôlez le niveau du signal en entrée du logiciel d’enregistrement
(consultez le mode d’emploi de Pro Tracks pour obtenir de plus amples renseignements sur l’affichage des
niveaux d’enregistrement).

2. Utilisez le bouton USB Level correspondant pour augmenter ou atténuer le niveau du signal transféré au
logiciel d’enregistrement. La plage d’atténuation/amplification est de -6 dB (usb1-2 -6) à +24 dB (usb1-
2 24).

Utilisation du pédalier RPxFC pour l’enregistrement

Le Vx400 dispose d’une embase située en face arrière et vous permettant de connecter un pédalier RPxFC
optionnel. Ceci vous permet de commander les fonctions d’enregistrement du Vx400. Ce triple pédalier
permet de commander les fonctions STOP/UNDO, RECORD et PLAY au pied. Le pédalier RPxFC est
parfait pour l’enregistrement car il libère les pédales du RPx400 pour les changements de Presets et la
commutation des canaux d’amplificateur. Le RPxFC est alors utilisé uniquement pour contrôler le logiciel Pro
Tracks. Utilisez uniquement un câble Jack 6,35 mm stéréo pour connecter le RPxFC au Vx400.

Les fonctions du RPxFC sont identiques à celles des pédales du Vx400 lorsque vous êtes en mode
d’enregistrement. Consultez la section Utilisation des pédales du Vx400 pour l’enregistrement.
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Utilitaires
Initialisation d’usine
Cette fonction permet de reconfigurer le Vx400 sur ses réglages d’usine. Cette procédure efface tous les
Presets utilisateur et recalibre la pédale d’expression.

ATTENTION : Cette fonction efface toutes les données programmées par l’utilisateur.Assurez-
vous que vous souhaitez effacer toutes vos données avant de lancer cette procédure.

la procédure d’initialisation est la suivante :
1. Déconnectez l’alimentation du Vx400.
2. Maintenez la touche Select enfoncée pendant la remise sous tension du Vx400.
3. Lorsque l’écran affiche rEsEt?, relâchez la touche Select et appuyez sur la touche Store. L’écran affiche

reset, indiquant que le Vx400 est revenu à ses réglages d’usine. Le Vx400 passe alors automatiquement au
calibrage de la pédale d’expression. Suivez les étapes 4 à 7 de la section sur le calibrage de la pédale d’ex-
pression.

Calibrage de la pédale d’expression
La pédale d’expression doit être recalibrée après une initialisation sur les réglages d’usine. Cette fonction s’af-
fiche automatiquement après une initialisation. Dans le cas où le calibrage viendrait à échouer, ou si la pédale
ne fonctionne pas correctement, utilisez la fonction de calibrage. Ceci n’efface pas les Presets utilisateur. La
procédure de calibrage de la pédale est la suivante :
1. Déconnectez l’alimentation PS0913B à l’arrière du Vx400.
2. Maintenez la pédale BAS enfoncée lors de la mise sous tension.
3. Maintenez la pédale BAS enfoncée jusqu’à ce que l’écran affiche calib.
4. Lorsque l’écran affiche TOE DN, placez la pédale en position basse.
5. Appuyez sur n’importe quelle pédale. L’écran affiche toe up.
6. Placez la pédale en position haute.
7. Appuyez sur n’importe quelle pédale. L’écran affiche VSWTCH, indiquant que vous venez d’entrer dans le

menu de réglage de sensibilité du V-Switch.
8. Si vous ne souhaitez pas régler la sensibilité du V-Switch, appuyez sur n’importe quelle pédale pour revenir

en mode de jeu.
Remarque : Si Error s’affiche, reprenez les étapes 4 à 8.

Sensibilité du V-Switch
Si vous souhaitez régler la sensibilité du V-Switch, suivez les étapes 1 à 7 du calibrage de la pédale d’expres-
sion, puis procédez comme suit :
1. Lorsque l’écran affiche VSWTCH, placez la pédale d’expression en position basse et appuyez jusqu’à ce que

l’écran affiche DONE.
2. Lorsque l'écran clignote entre DONE (avec la sensibilité du V-Switch affichée) et VSWTCHOn (ou VSWTCHOf,

selon si le V-Switch est actif ou inactif), vous pouvez contrôler la sensibilité du V-Switch en appliquant la
pression sur la position basse de la pédale d’expression.

3. Tournez le bouton 5 pour modifier la valeur de sensibilité du V-Switch.Vous pouvez contrôler la nouvelle
valeur en appliquant la pression sur la pédale d’expression, en position basse.

4. Une fois la valeur de sensibilité sélectionnée, appuyez sur n’importe quelle pédale. Le Vx400 repasse en
mode de jeu et vos réglages sont automatiquement sauvegardés.
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La lecture audio de Pro Tracks comprend des bruits de pop et de clic.
•  Essayez le Wave Profiler dans Options->Audio. Ceci semble résoudre la majorité des problèmes. Dans le cas

contraire, essayez d’utiliser les Drivers MME dans Options->Audio->Advanced, Driver Mode. Ce sont les
Drivers les plus communs, mais également ceux qui offrent le temps de latence le plus élevé.

•  Essayez d’augmenter la valeur de latence dans les réglages audio.

Les commandes d’enregistrement au pied du Vx 400 ne fonctionnent pas, ou plus.
•  Si elles fonctionnaient, essayez de quitter Pro Tracks et de le relancer (sauvegardez avant !).
•  Placez le Vx 400 hors et sous tension avant de lancer Pro Tracks ou X-Edit.
•  Si les commandes n’ont jamais fonctionné, il y a un problème de MIDI USB.Vous utilisez les mauvais Drivers

et/ou .dll ou ils sont mal installés. Un câble USB défectueux peut en être aussi la cause.
•  Consultez la section sur l’installation des Drivers.

Lecture impossible depuis Pro Tracks.
•  Si le mode de traitement des pistes par le Vx 400 est actif, changez de mode.
•  Assurez-vous que les Faders de Pro Tracks ne sont pas au minimum.
•  Vérifiez que les pistes ne sont pas coupées (Mute).
•  Accédez au menu Options->Audio->Drivers et dans Output Drivers, sélectionnez ‘DigiTech USB 1-2

In/Out’ et désélectionnez toute autre option.
•  Consultez la section sur l’installation des Drivers.

Le Vx 400 n’enregistre pas dans Pro Tracks.
•  Accédez au menu Options->Audio->Drivers et dans Output Drivers, sélectionnez ‘DigiTech USB 1-2

In/Out’ et ‘DigiTech USB 3-4 In Only’ et désélectionnez toute autre option.
•  Assurez-vous que vous avez installé les bons Drivers.
•  Consultez la section sur l’installation des Drivers.
•  Pour la première piste, assurez-vous que le mode ‘ReMIC’ du Vx 400 n’est pas utilisé.

Je n’arrive pas à traiter mes pistes enregistrées dans le Vx400.
•  Consultez la section sur le Traitement des pistes enregistrées par le Vx400 de ce mode d’emploi.

Pro Tracks se bloque.
•  Fermez tous les programmes autres que Pro Tracks. Contrôlez le Gestionnaire de tâches, et assurez-vous qu’il

n’y a pas une application cachée qui tourne en fond.
•  Essayez de réduire le nombre de Plug-ins et de synthés virtuels.
•  Augmentez la mémoire de votre système.
•  Procurez-vous un disque dur plus rapide.
•  Sauvegardez vos données audio sur un disque dur différent de celui sur lequel est installé le système d’exploita-

tion et vos applications.
•  Utilisez un ordinateur plus rapide.
•  Consultez la section sur les systèmes requis.

Où sont mes fichiers Wave ?
•  Les fichiers Wave sont tous sauvegardés dans le répertoire spécifié dans Options->Global, Audio Data.

Le volume de mes fichiers Wave est trop élevé/bas.
•  Vous pouvez modifier le niveau d’enregistrement à l’aide des boutons USB1-2 et USB3-4 Level.

Le niveau de lecture de Pro Tracks est supérieur à celui de mon chant
•  Vous pouvez régler le mixage de lecture avec le bouton Playback Mix.
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Assistance technique
J’ai des décrochages audio en enregistrement.

•  Essayez d'augmenter le temps de latence dans les réglages Audio.
•  Essayez de réduire le nombre de pistes de votre projet (le faite de Muter les pistes ne change rien.Vous devez

archiver les pistes ou les effacer).
•  Fermez tous les programmes autres que Pro Tracks. Contrôlez le Gestionnaire de tâches, et assurez-vous qu’il n’y a

pas une application cachée qui tourne en fond.
•  Essayez de réduire le nombre de Plug-ins et de synthés virtuels.
•  Augmentez la mémoire de votre système.
•  Procurez-vous un disque dur plus rapide.
•  Sauvegardez vos données audio sur un disque dur différent de celui sur lequel est installé le système d’exploitation

et vos applications.
•  Utilisez un ordinateur plus rapide.

Lorsque je lance X Edit, il ne trouve pas le Vx 400.
•  Assurez-vous que vos Drivers sont correctement chargés et que le câble USB est correctement connecté.
•  Consultez la section sur l’installation des Drivers USB.

La lecture est doublée.
•  L’écoute des entrées est probablement active. Désactivez dans Options->Audio->Input Monitoring.

Les réglages Bass, Mid et Treble ne fonctionnent pas.
•  Avec la connexion USB, les réglages Bass, Mid et Treble contrôlent les fonctions Playback Mix, USB 1-2 Level, et

USB 3-4 Level. Utilisez le tableau d’édition ou le logiciel X Edit pour régler les graves, médiums et aigus.

Je n’arrive pas à enregistrer l’instrument.
•  Vous pouvez enregistrer l’instrument sans traitement, uniquement sur une piste individuelle et non dans un mixage.

Sélectionnez Setup dans le tableau d’effets et sélectionnez DRYINS dans USB1-2 Source ou USB3-4 Source.
•  Vous pouvez enregistrer le micro avec réverbération ou effets avec le mixage guitare. La configuration du micro

doit être réglée sur INSRVB ou INS FX.

Je n’arrive pas à enregistrer mes sons de batterie.
•  La batterie peut être enregistrée uniquement sur une piste séparée, et non dans le mixage. Pour enregistrer la bat-

terie, sélectionnez Setup dans le tableau et sélectionnez Drums dans USB1-2 Source ou USB3-4 Source.

Je n’arrive pas à enregistrer mes entrées ligne.
•  Vous pouvez enregistrer les entrées ligne sans traitement uniquement sur une piste individuelle et non dans un

mixage. Sélectionnez Setup dans le tableau d’effets et sélectionnez DRYLIN in USB1-2 Source ou USB3-4
Source.

•   Vous pouvez enregistrer les entrées ligne avec réverbération ou effets avec le mixage guitare. La configuration des
entrées ligne doit être réglée sur LINRVB ou LINEFX.

j’ai des décrochages lorsque je change de Preset lors de l’enregistrement ou de la lecture.
•  Ne changez pas de Preset lors de l’enregistrement ou de la lecture.

j’ai des décrochages sur mes entrées micro/ligne lorsque j’enregistre.
•  Ne changez pas de Preset lors de l’enregistrement.

Pro Tracks ne démarre pas.
•  Il y a sûrement eu une interruption de connexion USB lors de la session précédente de Pro Tracks.Vous devez

redémarrer votre système pour résoudre ce problème.

Je n’entends pas la lecture de la liaison USB 3-4.
•  La lecture n’est possible qu’avec USB1-2. USB3-4 ne servent qu’à l’enregistrement.
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Annexes 
Paramètres de CC 
CC Paramètre
12 MIC ON/OFF
13 MIC SOURCE
14 MIC MODEL
15 COMP ON/OFF
16 COMP TYPE 
17 COMP GAIN 
18 VOICE ON/OFF          
19 VOICE TYPE       
20 VOICE PARAM1        
21 VOICE PARAM2         
22 VOICE LEVEL        
23 VOICE BYPASSLVL          
24 EQ MIDFREQ         
25 EQ BASS         
26 EQ MIDRANGE      
27 EQ TREBLE         
28 GATE ON/OFF       
29 GATE THRESH         
30 FX ON/OFF    
31 FX TYPE           
32 FX PARAM1         
33 FX PARAM2     
34 FX LEVEL/MIX           
35 DLY ON/OFF      
36 DLY TYPE           
37 DLY TIME      
38 DLY FEEDBACK        
39 DLY LEVEL        
40 RVB ON/OFF        
41 RVB TYPE          
42 RVB DAMP          
43 RVB DECAY           
44 RVB LEVEL      
45 PDL1 ASSIGN 
46 PDL1 MIN     
47 PDL1 MAX         
48 PDL2 ASSIGN      
49 PDL2 MIN        
50 PDL2 MAX         
51 PDL3 ASSIGN
52 PDL3 MIN     
53 PDL3 MAX     

CC Paramètre
4 GLB PEDAL1POSITION
7  GLB MASTER LEVEL
75 GLB INSTRUMENT ROUTE
76 GLB LINEIN ROUTE
77 GLB USB1 ROUTE
78 GLB USB2 ROUTE
79 GLB OUTPUT ROUTE
80 GLB USB1 LEVEL
81 GLB USB2 LEVEL
82 GLB USB MIX
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Annexes
Liste des Presets usine

Caractéristiques :
Entrées :
Instrument In : Jack 6,35 mm asymétrique 
Mic In : XLR symétrique avec alimentation fantôme
Line In : Jack stéréo 6,35 mm symétrique 
CD/Monitor : Jack stéréo 3,5 mm 
Footswitch : Jack stéréo 6,35 mm 
USB : Version 1.1

Sorties :
Line : Jack 6,35 mm asymétrique 
Line : XLR symétrique 
Headphone : Jack stéréo 3,5 mm 
USB : Version 1.1

Conversion A/N/A :
24 bits, Delta Sigma

Boîte à rythmes :
30 Patterns + métronome 

Effets de simulation :
8 maximum

Consommation électrique :
10 Watts 

Débit en courant :
675 mA, tension alternative 

Adaptateurs secteur :
9 Vca, 1,3 A 
DigiTech PS0913B — 100 (100 V~ 50/60 Hz)
DigiTech PS0913B — 120 (120 V~ 60 Hz)
DigiTech PS0913B — 230 (230 V~ 50 Hz)
DigiTech PS0913B — 240 (240 V~ 50 Hz)

Presets :
40 Presets utilisateur
40 Presets usine 

Effet s:
Modèles de micros Compresseur, Noise Gate, Mic Pre /
Voice, EQ, Chorus, Flanger, Phaser,Tremolo,Vibrato, Strobe,
Doubler, Envelope, Pixelator, Detune, Pitch,Whammy™,
Delay et Reverb.

Dimensions :
216 mm (p) x 330 mm (l) x 57 mm (h)

Poids :
2,2 kg  
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